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Abstract

Read this document for instructions about how to install Red Hat OpenShift Data Foundation using
Red Hat OpenShift Container Platform on Red Hat Virtualization platform.
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MAKING OPEN SOURCE MORE INCLUSIVE

MAKING OPEN SOURCE MORE INCLUSIVE

Red Hat is committed to replacing problematic language in our code, documentation, and web
properties. We are beginning with these four terms: master, slave, blacklist, and whitelist. Because of the
enormity of this endeavor, these changes will be implemented gradually over several upcoming releases.
For more details, see our CTO Chris Wright's message.


https://www.redhat.com/en/blog/making-open-source-more-inclusive-eradicating-problematic-language
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PROVIDING FEEDBACK ON RED HAT DOCUMENTATION

We appreciate your input on our documentation. Do let us know how we can make it better. To give
feedback:

® Forsimple comments on specific passages:

1. Make sure you are viewing the documentation in the Multi-page HTML format. In addition,
ensure you see the Feedback button in the upper right corner of the document.

2. Use your mouse cursor to highlight the part of text that you want to comment on.
3. Click the Add Feedback pop-up that appears below the highlighted text.
4. Follow the displayed instructions.

® For submitting more complex feedback, create a Bugzilla ticket:

1. Go to the Bugzilla website.
2. In the Component section, choose documentation.

3. Fillin the Description field with your suggestion for improvement. Include a link to the
relevant part(s) of documentation.

4. Click Submit Bug.


https://bugzilla.redhat.com/enter_bug.cgi?product=Red Hat OpenShift Data Foundation

PREFACE

PREFACE

Red Hat OpenShift Data Foundation 4.9 supports deployment on existing Red Hat OpenShift Container
Platform (RHOCP) Red Hat Virtualization platform clusters.

Deploying OpenShift Data Foundation on OpenShift Container Platform using shared storage devices
provided by Red Hat Virtualization installer-provisioned infrastructure (IPl) enables you to create
internal cluster resources.

Also, it is possible to deploy only the Multicloud Object Gateway (MCG) component with OpenShift
Data Foundation.

NOTE

Only internal OpenShift Data Foundation clusters are supported on Red Hat
Virtualization platform. See Planning your deployment for more information about
deployment requirements.

Based on your requirement, perform one of the following methods of deployment:

® Deploy using dynamic storage devices for the full deployment of OpenShift Data Foundation
using dynamic storage devices.

® Deploy using local storage devices for the full deployment of OpenShift Data Foundation using
local storage devices.

® Deploy standalone Multicloud Object Gateway component for deploying only the Multicloud
Object Gateway component with OpenShift Data Foundation.


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#deploy-using-dynamic-storage-devices-rhv
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#deploy-using-local-storage-devices-rhv
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#deploy-standalone-multicloud-object-gateway
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CHAPTER 1. PREPARING TO DEPLOY OPENSHIFT DATA
FOUNDATION USING RED HAT VIRTUALIZATION PLATFORM

Before you begin the deployment of Red Hat OpenShift Data Foundation using dynamic or local
storage, ensure that your resource requirements are met. See Planning your deployment.

1. Optional: If you want to enable cluster-wide encryption using an external Key Management
System (KMS):

® Ensure that a policy with a token exists and the key value backend path in Vault is enabled.
See enabled the key value backend path and policy in Vault .

® Ensure that you are using signed certificates on your Vault servers.

2. Minimum starting node requirements [Technology Preview]
An OpenShift Data Foundation cluster will be deployed with minimum configuration when the
standard deployment resource requirement is not met. See Resource requirements section in
Planning guide.

3. Regional-DR requirements [Developer Preview]
Disaster Recovery features supported by Red Hat OpenShift Data Foundation require all of the
following prerequisites in order to successfully implement a Disaster Recovery solution:

® Avalid Red Hat OpenShift Data Foundation Advanced entitlement

® Avalid Red Hat Advanced Cluster Management for Kubernetes subscription
To know how subscriptions for OpenShift Data Foundation work, see knowledgebase article
on OpenShift Data Foundation subscriptions.

For detailed requirements, see Regional-DR requirements and RHACM requirements.

4. Ensure that the requirements for installing OpenShift Data Foundation using local storage
devices are met.

1.1. ENABLING KEY VALUE BACKEND PATH AND POLICY IN VAULT

Prerequisites
® Administrator access to Vault.

e Carefully, choose a unique path name as the backend path that follows the naming convention
since it cannot be changed later.

Procedure

1. Enable the Key/Value (KV) backend path in Vault.
For Vault KV secret engine API, version 1:

I $ vault secrets enable -path=odf kv

For Vault KV secret engine API, version 2:

I $ vault secrets enable -path=odf kv-v2


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index#resource-requirements_rhodf
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_amazon_web_services/index#enabling-key-value-backend-path-and-policy-in-vault_rhodf
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index#resource-requirements_rhodf
https://access.redhat.com/articles/6932811
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/configuring_openshift_data_foundation_for_regional-dr_with_advanced_cluster_management#requirements-for-enabling-regional-disaster-recovery_rhodf
https://access.redhat.com/documentation/en-us/red_hat_advanced_cluster_management_for_kubernetes/2.4/html/install/index#requirements-and-recommendations
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#requirements-for-installing-openshift-data-foundation-using-local-storage-devices_rhodf
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2. Create a policy to restrict users to perform a write or delete operation on the secret using the
following commands.

echo'
path "odf/*" {

capabilities = ["create”, "read", "update”, "delete", "list"]
1

path "sys/mounts” {
capabilities = ["read"]
}'| vault policy write odf -

3. Create a token matching the above policy.

I $ vault token create -policy=0df -format json

1.2. REQUIREMENTS FOR INSTALLING OPENSHIFT DATA
FOUNDATION USING LOCAL STORAGE DEVICES

Node requirements

The cluster must consist of at least three OpenShift Container Platform worker nodes with locally
attached-storage devices on each of them.

® FEach of the three selected nodes must have at least one raw block device available to be used
by OpenShift Data Foundation.

® The devices you use must be empty; the disks must not include physical volumes (PVs), volume
groups (VGs), or logical volumes (LVs) remaining on the disk.

For more information, see the Resource requirements section in the Planning guide.

Regional-DR requirements [Developer Preview]

Disaster Recovery features supported by Red Hat OpenShift Data Foundation require all of the
following prerequisites in order to successfully implement a Disaster Recovery solution:

® Avalid Red Hat OpenShift Data Foundation Advanced entitlement
® Avalid Red Hat Advanced Cluster Management for Kubernetes subscription

To know how subscriptions for OpenShift Data Foundation work, see knowledgebase article on
OpenShift Data Foundation subscriptions.

For detailed requirements, see Regional-DR requirements and RHACM requirements.

Arbiter stretch cluster requirements [Technology Preview]

In this case, a single cluster is stretched across two zones with a third zone as the location for the arbiter.
This is a technology preview feature that is currently intended for deployment in the OpenShift
Container Platform on-premises.

For detailed requirements and instructions, see Configuring OpenShift Data Foundation for Metro-DR
stretch cluster.


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index#resource-requirements_rhodf
https://access.redhat.com/articles/6932811
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/configuring_openshift_data_foundation_for_regional-dr_with_advanced_cluster_management#requirements-for-enabling-regional-disaster-recovery_rhodf
https://access.redhat.com/documentation/en-us/red_hat_advanced_cluster_management_for_kubernetes/2.4/html/install/index#requirements-and-recommendations
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/configuring_openshift_data_foundation_for_metro-dr_stretch_cluster/index
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NOTE

Flexible scaling and Arbiter both cannot be enabled at the same time as they have
conflicting scaling logic. With Flexible scaling, you can add one node at a time to your
OpenShift Data Foundation cluster. Whereas in an Arbiter cluster, you need to add at
least one node in each of the two data zones.

Minimum starting node requirements [Technology Preview]

An OpenShift Data Foundation cluster is deployed with minimum configuration when the standard
deployment resource requirement is not met.

For more information, see Resource requirements section in the Planning guide.


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index#resource-requirements_rhodf

CHAPTER 2. DEPLOY USING DYNAMIC STORAGE DEVICES

CHAPTER 2. DEPLOY USING DYNAMIC STORAGE DEVICES

Deploying OpenShift Data Foundation on OpenShift Container Platform using dynamic storage devices
provided by Red Hat Virtualization gives you the option to create internal cluster resources. This results
in the internal provisioning of the base services, which helps to make additional storage classes available
to applications.

Ensure that you have addressed the requirements in Preparing to deploy OpenShift Data Foundation
chapter before proceeding with the below steps for deploying using dynamic storage devices:

1. Install the Red Hat OpenShift Data Foundation Operator .

2. Create the OpenShift Data Foundation Cluster.

2.1.INSTALLING RED HAT OPENSHIFT DATA FOUNDATION
OPERATOR

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

Prerequisites

® Access to an OpenShift Container Platform cluster using an account with cluster-admin and
Operator installation permissions.

® You must have at least three worker nodes in the Red Hat OpenShift Container Platform
cluster.

® Foradditional resource requirements, see the Planning your deployment guide.

IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command in the command line
interface to specify a blank node selector for the openshift-storage namespace
(create openshift-storage namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation chapter in the Managing and Allocating Storage
Resources guide.

Procedure
1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#preparing_to_deploy_openshift_data_foundation_using_red_hat_virtualization_platform
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#installing-openshift-data-foundation-operator-using-the-operator-hub_dynamicrhv-storage
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#creating-an-openshift-data-foundation-service_dynamicrhv-storage
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/managing_and_allocating_storage_resources/index#how-to-use-dedicated-worker-nodes-for-openshift-data-foundation_rhodf
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4. Click Install.

5. Set the following options on the Install Operator page:

Q

. Update Channel as stable-4.9.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.

NOTE

We recommend using all default settings. Changing it may result in unexpected behavior.
Alter only if you are aware of its result.

Verification steps

e Verify that the OpenShift Data Foundation Operator shows a green tick indicating successful
installation.

® After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

o Inthe Web Console, navigate to Operators and verify if OpenShift Data Foundationis
available.

IMPORTANT

In case the console plugin option was not automatically enabled after you installed the
OpenShift Data Foundation Operator, you need to enable it.

For more information on how to enable the console plugin, see Enabling the Red Hat
OpenShift Data Foundation console plugin.

2.2. CREATING AN OPENSHIFT DATA FOUNDATION CLUSTER

Create an OpenShift Data Foundation cluster after you install the OpenShift Data Foundation operator.

Prerequisites

10


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/troubleshooting_openshift_data_foundation/index#enabling-the-red-hat-openshift-data-foundation-console-plugin-option_rhodf
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® The OpenShift Data Foundation operator must be installed from the Operator Hub. For more
information, see Installing OpenShift Data Foundation Operator

Procedure

1. In the OpenShift Web Console, click Operators = Installed Operatorsto view all the installed
operators.
Ensure that the Project selected is openshift-storage.

2. Click on the OpenShift Data Foundation operator, and then click Create StorageSystem.
3. In the Backing storage page, select the following:

a. Select the Use an existing StorageClass option.

b. Expand Advanced and select Full Deployment for the Deployment type option.

c. Click Next.
4. In the Capacity and nodes page, provide the necessary information:

a. Select a value for Requested Capacity from the dropdown list. Itis set to 2 TiB by default.

NOTE

Once you select the initial storage capacity, cluster expansion is performed
only using the selected usable capacity (three times of raw storage).

b. In the Select Nodes section, select at least three available nodes.
c. Click Next.

5. Optional: In the Security and network page, configure the following based on your
requirements:

a. To enable encryption, select Enable data encryption for block and file storage
b. Choose either one or both the encryption levels:

® Cluster-wide encryption
Encrypts the entire cluster (block and file).

® StorageClass encryption
Creates encrypted persistent volume (block only) using encryption enabled storage
class.

c. Select the Connect to an external key management servicecheckbox. This is optional for
cluster-wide encryption.

i. Key Management Service Provideris set to Vault by default.

ii. Enter Vault Service Name, host Address of Vault server (‘https://<hostname or ip>"),
Port number and Token.

iii. Expand Advanced Settings to enter additional settings and certificate details based on
your Vault configuration:

1


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#installing-openshift-data-foundation-operator-using-the-operator-hub_dynamicrhv-storage
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A. Enter the Key Value secret path in Backend Path that is dedicated and unique to
OpenShift Data Foundation.

B. Optional: Enter TLS Server Name and Vault Enterprise Namespace

C. Upload the respective PEM encoded certificate file to provide the CA Certificate,
Client Certificate and Client Private Key .

D. Click Save.
d. Click Next.

6. In the Review and create page, review the configuration details.
To modify any configuration settings, click Back.

7. Click Create StorageSystem.

Verification steps
® To verify the final Status of the installed storage cluster:

a. Inthe OpenShift Web Console, navigate to Installed Operators = OpenShift Data
Foundation —» Storage System — ocs-storagecluster-storagesystem — Resources.

b. Verify that Status of StorageCluster is Ready and has a green tick mark next to it.

1. To verify that all the components for OpenShift Data Foundation are successfully
installed, see Verifying OpenShift Data Foundation deployment.

Additional resources

To enable Overprovision Control alerts, refer to Alerts in Monitoring guide.

12


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#verifying_openshift_data_foundation_deployment_rhv
https://access.redhat.com/documentation/en-us/red_hat_openshift_container_storage/4.8/html-single/monitoring_openshift_container_storage/index#alerts
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CHAPTER 3. DEPLOY USING LOCAL STORAGE DEVICES

Deploying OpenShift Data Foundation on OpenShift Container Platform using local storage devices
provides you with the option to create internal cluster resources. This results in the internal provisioning
of the base services, which helps to make additional storage classes available to applications.

Use this section to deploy OpenShift Data Foundation on Red Hat Virtualization where OpenShift
Container Platform is already installed.

Also, ensure that you have addressed the requirements in Preparing to deploy OpenShift Data
Foundation chapter before proceeding with the next steps.

1. Installing Local Storage Operator
2. Install the Red Hat OpenShift Data Foundation Operator .

3. Create the OpenShift Data Foundation Cluster.

3.1. INSTALLING LOCAL STORAGE OPERATOR

Install the Local Storage Operator from the Operator Hub before creating Red Hat OpenShift Data
Foundation clusters on local storage devices.

Procedure

1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Type local storage in the Filter by keyword box to find the Local Storage Operatorfrom the
list of operators and click on it.

4. Set the following options on the Install Operator page:

a. Update channel as either 4.9 or stable.

b. Installation mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-local-storage.
d. Update approval as Automatic.

5. Click Install.

Verification steps

e Verify that the Local Storage Operator shows a green tick indicating successful installation.

3.2. INSTALLING RED HAT OPENSHIFT DATA FOUNDATION
OPERATOR

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

13


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#preparing_to_deploy_openshift_data_foundation_using_red_hat_virtualization_platform
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#installing-local-storage-operator_local-storage-rhv
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#installing-openshift-data-foundation-operator-using-the-operator-hub_local-storage-rhv
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/deploying_openshift_data_foundation_using_red_hat_virtualization_platform/index#creating-openshift-data-foundation-cluster-on-red-hat-virtualization_local-storage-rhv
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Prerequisites

Access to an OpenShift Container Platform cluster using an account with cluster-admin and
Operator installation permissions.

You must have at least three worker nodes in the Red Hat OpenShift Container Platform
cluster.

For additional resource requirements, see the Planning your deployment guide.

IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command in the command line
interface to specify a blank node selector for the openshift-storage namespace
(create openshift-storage namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation chapter in the Managing and Allocating Storage
Resources guide.

Procedure

14

1.

2.

Log in to the OpenShift Web Console.
Click Operators = OperatorHub.

Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.

Click Install.

Set the following options on the Install Operator page:

o

Update Channel as stable-4.9.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/managing_and_allocating_storage_resources/index#how-to-use-dedicated-worker-nodes-for-openshift-data-foundation_rhodf
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NOTE

We recommend using all default settings. Changing it may result in unexpected behavior.
Alter only if you are aware of its result.

_,f"

Verification steps

e Verify that the OpenShift Data Foundation Operator shows a green tick indicating successful
installation.

® After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

o Inthe Web Console, navigate to Operators and verify if OpenShift Data Foundationis
available.

IMPORTANT

In case the console plugin option was not automatically enabled after you installed the
OpenShift Data Foundation Operator, you need to enable it.

For more information on how to enable the console plugin, see Enabling the Red Hat
OpenShift Data Foundation console plugin.

3.3. CREATING OPENSHIFT DATA FOUNDATION CLUSTER ON RED
HAT VIRTUALIZATION PLATFORM

Use this procedure to create an OpenShift Data Foundation Cluster using local storage devices after
you install the OpenShift Data Foundation operator.

Prerequisites

® The OpenShift Data Foundation operator must be installed from the Operator Hub. For more
information, see Installing OpenShift Data Foundation Operator.

® Ensure that all the requirements in the Requirements for installing OpenShift Data Foundation
using local storage devices section are met.

Procedure
1. In the OpenShift Web Console, click Operators = Installed Operatorsto view all the installed
operators.
Ensure that the Project selected is openshift-storage.
2. Click on the OpenShift Data Foundation operator and then click Create StorageSystem.

3. In the Backing storage page, perform the following:

a. Select the Create a new StorageClass using the local storage devicesoption.
b. Expand Advanced and select Full Deployment for the Deployment type option.

c. Click Next.
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NOTE

You are prompted to install the Local Storage Operator if it is not already
installed. Click Install and follows procedure as described in Installing Local
Storage Operator.

4. In the Create local volume set page, provide the following information:

a. Enter a name for the LocalVolumeSet and the StorageClass.
By default, the local volume set name appears for the storage class name. You can change
the name.

b. Choose one of the following:

e Disks on all nodesto use the available disks that match the selected filters on all nodes.

® Disks on selected nodesto use the available disks that match the selected filters only
on selected nodes.

IMPORTANT

o The flexible scaling feature is enabled only when the storage cluster
that you created with 3 or more nodes are spread across fewer than
the minimum requirement of 3 availability zones.

For information about flexible scaling, see Add capacity using YAML
section in Scaling Storage guide.

o If the nodes selected do not match the OpenShift Data Foundation
cluster requirement of an aggregated 30 CPUs and 72 GiB of RAM, a
minimal cluster is deployed.

For minimum starting node requirements, see Resource
requirements section in Planning guide.

c. From the available list of Disk Type, select SSD/NVMe.

d. Expand the Advanced section and set the following options:

Volume Block is selected by default.

Mode

Device Select one or more device type from the dropdown list.

Type

Disk Size Set a minimum size of 100GB for the device and maximum available size of the

device that needs to be included.

Maximum This indicates the maximum number of PVs that can be created on a node. If this
Disks Limit field is left empty, then PVs are created for all the available disks on the matching
nodes.
e. Click Next.

A pop-up to confirm the creation of LocalVolumeSet is displayed.

f. Click Yes to continue.
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5. In the Capacity and nodes page, configure the following:

a. Available raw capacityis populated with the capacity value based on all the attached disks
associated with the storage class. This takes some time to show up. The Selected nodes
list shows the nodes based on the storage class.

b. Click Next.

6. Optional: In the Security and network page, configure the following based on your requirement:
a. To enable encryption, select Enable data encryption for block and file storage
b. Choose one of the following Encryption level:

e Cluster-wide encryption to encrypt the entire cluster (block and file).

® StorageClass encryption to create encrypted persistent volume (block only) using
encryption enabled storage class.

c. Select Connect to an external key management servicecheckbox. This is optional for
cluster-wide encryption.

i. Key Management Service Provideris set to Vault by default.

ii. Enter Vault Service Name, host Address of Vault server (‘https://<hostname or ip>"),
Port number and Token.

iii. Expand Advanced Settings to enter additional settings and certificate details based on
your Vault configuration:

A. Enter the Key Value secret path in Backend Path that is dedicated and unique to
OpenShift Data Foundation.

B. Optional: Enter TLS Server Name and Vault Enterprise Namespace

C. Provide CA Certificate, Client Certificate and Client Private Key by uploading
the respective PEM encoded certificate file.

D. Click Save.
d. Click Next.

7. In the Review and create page, review the configuration details.

® To modify any configuration settings, click Back to go back to the previous configuration
page.

8. Click Create StorageSystem.

Verification steps
® To verify the final Status of the installed storage cluster:

a. Inthe OpenShift Web Console, navigate to Installed Operators = OpenShift Data
Foundation —» Storage System — ocs-storagecluster-storagesystem — Resources.

b. Verify that Status of StorageCluster is Ready and has a green tick mark next to it.
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e To verify if flexible scaling is enabled on your storage cluster, perform the following steps (for
arbiter mode, flexible scaling is disabled):

1. In the OpenShift Web Console, navigate to Installed Operators = OpenShift Data
Foundation — Storage System — ocs-storagecluster-storagesystem — Resources.

2. Inthe YAML tab, search for the keys flexibleScaling in spec section and failureDomain in
status section. If flexible scaling is true and failureDomain is set to host, flexible scaling
feature is enabled.

spec:
flexibleScaling: true

[...]
status:
failureDomain: host

® To verify that all components for OpenShift Data Foundation are successfully installed, see
Verifying your OpenShift Data Foundation deployment.

Additional resources

® To expand the capacity of the initial cluster, see Scaling Storage.
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CHAPTER 4. VERIFYING OPENSHIFT DATA FOUNDATION
DEPLOYMENT

Use this section to verify that OpenShift Data Foundation is deployed correctly.

4.1. VERIFYING THE STATE OF THE PODS

Procedure

1. Click Workloads = Podsfrom the OpenShift Web Console.

2. Select openshift-storage from the Project drop-down list.

NOTE

If the Show default projectsoption is disabled, use the toggle button to list all
the default projects.

For more information about the expected number of pods for each component and how it varies
depending on the number of nodes, see Table 4.1, “Pods corresponding to OpenShift Data
Foundation cluster”.

3. Click the Running and Completed tabs to verify that the following pods are in Running and
Completed state:

Table 4.1. Pods corresponding to OpenShift Data Foundation cluster

Component Corresponding pods

OpensShift Data Foundation Operator .
e ocs-operator-* (1 pod on any worker

node)

e ocs-metrics-exporter-* (1pod on any
worker node)

e odf-operator-controller-manager-*
(1 pod on any worker node)

e odf-console-* (1pod on any worker node)

Rook-ceph Operator rook-ceph-operator-*

(1 pod on any worker node)
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Component Corresponding pods

Multicloud Object Gatewa
: Y e noobaa-operator-* (1 pod on any worker

node)

e nhoobaa-core-* (1pod on any storage
node)

e noobaa-db-pg-* (1 pod on any storage
node)

e noobaa-endpoint-* (1pod on any storage
node)

MON rook-ceph-mon-*

(3 pods distributed across storage nodes)

MGR rook-ceph-mgr-*

(1 pod on any storage node)

MDS rook-ceph-mds-ocs-storagecluster-
cephfilesystem-*

(2 pods distributed across storage nodes)

RGW rook-ceph-rgw-ocs-storagecluster-
cephobjectstore-* (1 pod on any storage
node)

CSl

e cephfs

o csi-cephfsplugin-* (1pod on each
worker node)

o csi-cephfsplugin-provisioner-* (2
pods distributed across worker nodes)

e rbd

o csi-rbdplugin-* (1 pod on each worker
node)

o csi-rbdplugin-provisioner-* (2 pods
distributed across worker nodes)

rook-ceph-crashcollector rook-ceph-crashcollector-*

(1 pod on each storage node)
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Component Corresponding pods

OSsD
e rook-ceph-osd-* (1 pod for each device)

e rook-ceph-osd-prepare-ocs-
deviceset-* (1 pod for each device)

4.2. VERIFYING THE OPENSHIFT DATA FOUNDATION CLUSTERIIS
HEALTHY

Procedure

1. In the OpenShift Web Console, click Storage = OpenShift Data Foundation.

2. Inthe Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

3. In the Status card of the Block and File tab, verify that Storage Cluster has a green tick.
4. In the Details card, verify that the cluster information is displayed.

For more information on the health of the OpenShift Data Foundation cluster using the Block and File
dashboard, see Monitoring OpenShift Data Foundation.

4.3. VERIFYING THE MULTICLOUD OBJECT GATEWAY IS HEALTHY

Procedure

1. In the OpenShift Web Console, click Storage = OpenShift Data Foundation.

2. Inthe Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

a. Inthe Status card of the Object tab, verify that both Object Service and Data Resiliency
have a green tick.

b. In the Details card, verify that the MCG information is displayed.

For more information on the health of the OpenShift Data Foundation cluster using the object service
dashboard, see Monitoring OpenShift Data Foundation.

4.4. VERIFYING THAT THE OPENSHIFT DATA FOUNDATION SPECIFIC
STORAGE CLASSES EXIST

Procedure

1. Click Storage — Storage Classesfrom the left pane of the OpenShift Web Console.

2. Verify that the following storage classes are created with the OpenShift Data Foundation
cluster creation:
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e ocs-storagecluster-ceph-rbd
e ocs-storagecluster-cephfs
e openshift-storage.noobaa.io

e ocs-storagecluster-ceph-rgw
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CHAPTER 5. DEPLOY STANDALONE MULTICLOUD OBJECT
GATEWAY

Deploying only the Multicloud Object Gateway component with the OpenShift Data Foundation
provides the flexibility in deployment and helps to reduce the resource consumption. You can deploy
the Multicloud Object Gateway component either using dynamic storage devices or using the local
storage devices.

5.1. DEPLOY STANDALONE MULTICLOUD OBJECT GATEWAY USING
DYNAMIC STORAGE DEVICES

Use this section to deploy only the standalone Multicloud Object Gateway component, which involves
the following steps:

® |nstalling Red Hat OpenShift Data Foundation Operator

® Creating standalone Multicloud Object Gateway

5.1.1. Installing Red Hat OpenShift Data Foundation Operator

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

Prerequisites

® Access to an OpenShift Container Platform cluster using an account with cluster-admin and
Operator installation permissions.

® You must have at least three worker nodes in the Red Hat OpenShift Container Platform
cluster.

® Foradditional resource requirements, see the Planning your deployment guide.

IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command in the command line
interface to specify a blank node selector for the openshift-storage namespace
(create openshift-storage namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation chapter in the Managing and Allocating Storage
Resources guide.

Procedure

1. Login to the OpenShift Web Console.

2. Click Operators = OperatorHub.
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3. Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.

4. Click Install.

5. Set the following options on the Install Operator page:

o

Update Channel as stable-4.9.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.

NOTE

We recommend using all default settings. Changing it may result in unexpected behavior.
Alter only if you are aware of its result.

Verification steps

e Verify that the OpenShift Data Foundation Operator shows a green tick indicating successful
installation.

® After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

o Inthe Web Console, navigate to Operators and verify if OpenShift Data Foundationis
available.

IMPORTANT

In case the console plugin option was not automatically enabled after you installed the
OpenShift Data Foundation Operator, you need to enable it.

For more information on how to enable the console plugin, see Enabling the Red Hat
OpenShift Data Foundation console plugin.

5.1.2. Creating standalone Multicloud Object Gateway

Use this section to create only the Multicloud Object Gateway component with OpenShift Data
Foundation.

24


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.9/html-single/troubleshooting_openshift_data_foundation/index#enabling-the-red-hat-openshift-data-foundation-console-plugin-option_rhodf

CHAPTER 5. DEPLOY STANDALONE MULTICLOUD OBJECT GATEWAY

Prerequisites

® Ensure that OpenShift Data Foundation Operator is installed.
® (For deploying using local storage devices only) Ensure that Local Storage Operator is installed.

® Ensure that you have a storage class and is set as the default.

Procedure

1. In the OpenShift Web Console, click Operators — Installed Operators to view all the installed
operators.
Ensure that the Project selected is openshift-storage.

2. Click OpenShift Data Foundation operator and then click Create StorageSystem.
3. In the Backing storage page, expand Advanced.

4. Select Multicloud Object Gateway for Deployment type.

5. Click Next.

6. Optional: In the Security page, select Connect to an external key management service

a. Key Management Service Provideris set to Vault by default.

b. Enter Vault Service Name, host Address of Vault server (‘https:// <hostname or ip>"), Port
number, and Token.

c. Expand Advanced Settings to enter additional settings and certificate details based on
your Vault configuration:

i. Enter the Key Value secret path in the Backend Path that is dedicated and unique to
OpenShift Data Foundation.

ii. Optional: Enter TLS Server Name and Vault Enterprise Namespace

ii. Upload the respective PEM encoded certificate file to provide the CA Certificate,
Client Certificate, and Client Private Key.

iv. Click Save.
d. Click Next.

7. In the Review and create page, review the configuration details:
To modify any configuration settings, click Back.

8. Click Create StorageSystem.

Verification steps
Verifying that the OpenShift Data Foundation cluster is healthy

1. In the OpenShift Web Console, click Storage = OpenShift Data Foundation.

2. Inthe Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.
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a. Inthe Status card of the Object tab, verify that both Object Service and Data Resiliency
have a green tick.

b. In the Details card, verify that the MCG information is displayed.

Verify the state of the pods

1. Click Workloads = Pods from the OpenShift Web Console.

2. Select openshift-storage from the Project drop-down list and verify that the following
pods are in Running state.

NOTE

L

If the Show default projectsoption is disabled, use the toggle button to list
all the default projects.

Component Corresponding pods

OpenShift Data

*
Foundation Operator e ocs-operator-* (1 pod on any worker node)

e ocs-metrics-exporter-* (1 pod on any worker node)

e odf-operator-controller-manager-* (1pod on any worker
node)

e odf-console-* (1pod on any worker node)

Rook-ceph Operator rook-ceph-operator-*

(1 pod on any worker node)

Multicloud Object

*
Gateway e noobaa-operator-* (1pod on any worker node)

e noobaa-core-* (1pod on any worker node)
e noobaa-db-pg-* (1 pod on any worker node)

e noobaa-endpoint-* (1pod on any worker node)

5.2. DEPLOY STANDALONE MULTICLOUD OBJECT GATEWAY USING
LOCAL STORAGE DEVICES

Use this section to deploy only the standalone Multicloud Object Gateway component, which involves
the following steps:

® |nstalling the Local Storage Operator

® Installing Red Hat OpenShift Data Foundation Operator
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® Creating standalone Multicloud Object Gateway

5.2.1. Installing Local Storage Operator

Install the Local Storage Operator from the Operator Hub before creating Red Hat OpenShift Data
Foundation clusters on local storage devices.

Procedure

1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Type local storage in the Filter by keyword box to find the Local Storage Operatorfrom the
list of operators and click on it.

4. Set the following options on the Install Operator page:

a. Update channel as either 4.9 or stable.

b. Installation mode as A specific namespace on the cluster

0

Installed Namespace as Operator recommended namespace openshift-local-storage.
d. Update approval as Automatic.

5. Click Install.

Verification steps

e Verify that the Local Storage Operator shows a green tick indicating successful installation.

5.2.2. Installing Red Hat OpenShift Data Foundation Operator

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

Prerequisites

® Access to an OpenShift Container Platform cluster using an account with cluster-admin and
Operator installation permissions.

® You must have at least three worker nodes in the Red Hat OpenShift Container Platform
cluster.

® Foradditional resource requirements, see the Planning your deployment guide.
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IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command in the command line
interface to specify a blank node selector for the openshift-storage namespace
(create openshift-storage namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation chapter in the Managing and Allocating Storage
Resources guide.

Procedure

1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.

4. Click Install.

5. Set the following options on the Install Operator page:

o

Update Channel as stable-4.9.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.

NOTE

We recommend using all default settings. Changing it may result in unexpected behavior.
Alter only if you are aware of its result.

Verification steps

e Verify that the OpenShift Data Foundation Operator shows a green tick indicating successful
installation.
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After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

o Inthe Web Console, navigate to Operators and verify if OpenShift Data Foundationis
available.

IMPORTANT

In case the console plugin option was not automatically enabled after you installed the
OpenShift Data Foundation Operator, you need to enable it.

For more information on how to enable the console plugin, see Enabling the Red Hat
OpenShift Data Foundation console plugin.

5.2.3. Creating standalone Multicloud Object Gateway

Use this section to create only the Multicloud Object Gateway component with OpenShift Data
Foundation.

Prerequisites

Ensure that OpenShift Data Foundation Operator is installed.
(For deploying using local storage devices only) Ensure that Local Storage Operator is installed.

Ensure that you have a storage class and is set as the default.

Procedure

1.

In the OpenShift Web Console, click Operators — Installed Operators to view all the installed
operators.
Ensure that the Project selected is openshift-storage.

Click OpenShift Data Foundation operator and then click Create StorageSystem.
In the Backing storage page, expand Advanced.

Select Multicloud Object Gateway for Deployment type.

Click Next.

Optional: In the Security page, select Connect to an external key management service

a. Key Management Service Provideris set to Vault by default.

b. Enter Vault Service Name, host Address of Vault server (‘https:// <hostname or ip>"), Port
number, and Token.

c. Expand Advanced Settings to enter additional settings and certificate details based on
your Vault configuration:

i. Enter the Key Value secret path in the Backend Path that is dedicated and unique to
OpenShift Data Foundation.

ii. Optional: Enter TLS Server Name and Vault Enterprise Namespace
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ii. Upload the respective PEM encoded certificate file to provide the CA Certificate,
Client Certificate, and Client Private Key.

iv. Click Save.
d. Click Next.

7. In the Review and create page, review the configuration details:
To modify any configuration settings, click Back.

8. Click Create StorageSystem.

Verification steps
Verifying that the OpenShift Data Foundation cluster is healthy

1. In the OpenShift Web Console, click Storage = OpenShift Data Foundation.

2. Inthe Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

a. Inthe Status card of the Object tab, verify that both Object Service and Data Resiliency
have a green tick.

b. In the Details card, verify that the MCG information is displayed.

Verify the state of the pods

1. Click Workloads = Pods from the OpenShift Web Console.

2. Select openshift-storage from the Project drop-down list and verify that the following
pods are in Running state.

NOTE

If the Show default projectsoption is disabled, use the toggle button to list
all the default projects.

Component Corresponding pods

OpenShift Data
Foundation Operator

L

e ocs-operator-* (1pod on any worker node)
e ocs-metrics-exporter-* (1 pod on any worker node)

e odf-operator-controller-manager-* (1pod on any worker
node)

e odf-console-* (1pod on any worker node)

Rook-ceph Operator rook-ceph-operator-*

(1 pod on any worker node)
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Component Corresponding pods

Multicloud Object

*
Gateway e noobaa-operator-* (1pod on any worker node)

e noobaa-core-* (1pod on any worker node)
e noobaa-db-pg-* (1 pod on any worker node)

e noobaa-endpoint-* (1pod on any worker node)
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CHAPTER 6. UNINSTALLING OPENSHIFT DATA FOUNDATION

6.1. UNINSTALLING OPENSHIFT DATA FOUNDATION IN INTERNAL
MODE

To uninstall OpenShift Data Foundation in Internal mode, refer to the knowledge base article on
Uninstalling OpenShift Data Foundation.
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